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Here is an outline of the four videos, along with website links, EXCEL formulas, and sample class 
announcements. But no screen shots or graphics. 
 
Part 1. Uploading a spreadsheet of text to Canvas. 
Overview of workflow to get a Canvas roster, type seats into it manually, and upload it. Partly 
based on correspondence with Ed Ruiz in UCSD’s IT Services. 
 
Part 2. Seating Charts 
Getting seating charts, handling special seat requests (accommodations, left-handed seats, …), 
and assigning randomized seats (replaces manual step in Part 1) 
 
Part 3. Exam logistics 
 
Part 4. How to sort the roster into seat order 
This gives extra steps to prepare the AIO seat spreadsheets so that you’ll be able to sort the 
roster into seat order. 
 
 
  



Part 1. Overview of getting a Canvas roster, typing seats into it manually, 
and uploading it to Canvas 
 
Add the “Submission Comments” tool to your class: 

• Go to your course on Canvas (this must be done once for each class you’ll use it in) 
• In your course’s menu, pick “Modules” 

 
• Click on “+Module”. This brings up a form: 

o Enter a module name, “Admin Tools” 
o Click on “Add Module” 

 
• Now we have an empty module called “Admin Tools”. 
• On “Admin Tools”, use “+” to add an item to it. This brings up a form. 

o On “Add”, select “External Tool” 
o This brings up a list of tools. Scroll to select “Submission Comments” 
o Selecting it fills in the “URL” field at the bottom 
o Click on “Add Item” 

 
• Now the “Admin Tools” module has an item “Submission Comments” 

• Leave both the “Admin Tools” module and the “Submission Comments” item under 
it unpublished. They will work fine for the instructor without being published. 

• Only the instructor uses it, not the students, so they don’t need access to it. 
• If you have other modules for your class, such as the modules on Chapters 1, 2, 3, …, 

then if this was published, it would show on the same page, cluttering it. 
 

  



Workflow for each exam you’ll do a seat assignment on: 
• Download roster from Canvas gradebook 
• Use the roster to make a spreadsheet of seat assignments 
• Create a Canvas Assignment Group “Seat Assignments” (optional, once per course) 
• Create a Canvas Assignment “Midterm 1 Seat Assignment” 
• Upload spreadsheet to the Canvas Assignment 

 
Download roster from Canvas gradebook: 

• Go to Grades screen 
• At top, pick Actions 
• On Actions menu, pick Export 
• That downloads a file to your computer with a name like 

                                                   2021-10-09T2230_Grades-Math283_FA21_A00.csv 
• Optionally rename it, e.g.,    canvas_roster_mt1.csv 

 
 
Use the roster to enter seats in EXCEL (or other spreadsheet software): 

• Open the roster file (canvas_roster_mt1.csv) in EXCEL 
• Keep the first 4 columns: Student, ID, SS User ID, SS Login ID 
• Optionally keep the 5th column, Section 
• Select and delete all other columns (they’re scores on various assignments) 
• Now you have four columns (A-D) or five (A-E) 

 
• Make a new column, “Comments” 

o In the title row, enter the word “Comments” at the top. 
o In each student row, enter text in the “Comments” column, such as “Seat A-1”, 

“Staff - No seat”, “Seat: OSD separate room”, or “Room SOLIS 104, Seat A-5”. 
o The text you enter for “Student, Test” is what you’ll see when you use the 

“Student View” in Canvas. 
 

• Save it in CSV format 
o EXCEL:    File → Save As… → Pick “CSV” for the format 
o Google Sheets: File → Download → Comma-separated values 
o Numbers:  File → Export To → CSV… 

 



Create a Canvas Assignment Group (optional) 
• If you’re using Canvas Assignment Groups, then you should create a “Seat Assignments” 

group once per course so that the seat assignments don’t get mixed in with the others. 
• Go to your “Assignments” page 
• Click on “+Group”. This brings up a form. Fill it in: 

 
Group Name Seat Assignments 

(or any other name) 
% of total grade 0 
To submit it Click on “Save” 

 
 
Create a Canvas Assignment “Midterm 1 Seat Assignment” 

• Must create a new Canvas Assignment for each exam (unless you’re using the same 
assigned seats) 

• Go to your “Assignments” page, click on “+Assignment”, and fill in the form: 
 

Title Midterm 1 Seat Assignment 
(or any other name) 

Description It’s safe to leave it blank, but here are example 
instructions you could add: 
 
Please check this assignment’s comment section for your 
seat assignment: 

• Click on Grades in the course menu 
• Click on the comments icon for “Midterm 1 Seat 

Assignment” 
• Note your seat assignment, e.g., H-5 

Points 0 
Assignment Group Seat Assignments 

(or whatever you named the assignment group; if you 
didn’t create an assignment group, it’s fine to use the 
default “Assignments”) 

Display Grade as Points 
Do not count this 
assignment towards the 
final grade 

Check the box 

Submission Type No Submission 
To submit it: Use “Save & Publish” 

(if you only use “Save” now, you will have to publish it 
before you can actually upload anything to it) 

 
 



Uploading the seat assignment spreadsheet (CSV file) to Canvas: 
• Go to the “Modules” page and click on “Submission Comments”. 
• This brings up a form and instructions. Fill in the form: 

 
Add comments to the assignment Midterm 1 Seat Assignment 

(or whatever you called it) 
Choose File canvas_roster_mt1.csv 

(or whatever you called it) 
To submit it: 1. Press “Preview Assignment Comments” 

2. Scroll to verify it uploaded correctly 
3. Use “Add Comments to Students” 

 
 
Sample Canvas Announcement: instructions for students to view their seat assignment: 

Assigned seats for Midterm 1 have been posted, and some students will be in a second room. 
Please view your room and seat assignment as follows: 
 

• Open this class in Canvas and click on Grades in the course menu 
• Click on the comments icon for Midterm 1 Seat Assignment 
• Note your assigned room and seat, e.g., Center 109, Seat H-5 
• Seat number map for the regular classroom Center 109: 

https://facilities.ucsd.edu/Database/CAP/171/347/Center_109.pdf 
• Seat number map for the second classroom Center 105: 

https://facilities.ucsd.edu/Database/CAP/171/345/Center_105.pdf 
 

 
On further exams, you should send new instructions explaining any differences. For example, if 
Midterm 2 is in one room and with new seat assignments: 

Assigned seats for Midterm 2 have been posted. They are different than on Midterm 1, and 
everyone will be in the regular classroom, Center 109; we are not using a second classroom. 
Please view your seat assignment as follows: 
 

• Open this class in Canvas and click on Grades in the course menu 
• Click on the comments icon for Midterm 2 Seat Assignment 
• Note your assigned seat, e.g., Seat H-5 
• Seat number map for Center 109: 

https://facilities.ucsd.edu/Database/CAP/171/347/Center_109.pdf 
 

 
Also, if you change seat assignments for each exam, you may want to unpublish “Midterm 1 
Seat Assignment” when you publish “Midterm 2 Seat Assignment”. This way, the students will 
only be able to see the current exam’s seat assignment, which may reduce confusion. 
 



 
Instructor view of seat assignments in Canvas: 

• Go to your Assignments page and click on “Midterm 1 Seat Assignment” 
• There should be a link for SpeedGrader. However, if your assignment is not published, 

you will need to publish it and then either refresh the screen, or leave this page and 
come back to it, to get the SpeedGrader link to show. 

• Click on the SpeedGrader link. 
• In the upper right, use the arrows or name menu to go through one student at a time. 
• The main area on the left would usually show the student’s submitted work, but it’s 

blank since students don’t submit anything for this assignment. 
• On the right, the “Assignment Comments” shows the seat assignment. 

 
To make minor changes to the seat assignments (e.g., for a handful of students): 

• Continue from the point above, where we used SpeedGrader and found their 
assignment comment. 

• Use  ⨉  next to the comment to delete it. 
• Enter a new seat assignment in “Add a Comment” and hit “Submit”. 
• That only updates it within Canvas. You should also make the same change on your 

spreadsheet and should email or otherwise notify the student that you changed it. 
 
But if you have to the whole seat assignment (e.g., exam moved to a new room): 

• If you upload a spreadsheet twice to the same assignment, students will see BOTH sets 
of comments, which would be confusing. 

• Instead, delete or unpublish the original Canvas Assignment “Midterm 1 Seat 
Assignment”, and redo everything from scratch with a new Canvas Assignment 
“Updated Midterm 1 Seat Assignment”. 

• Notify your class about the change and that they need to look up their new seat 
assignment. 

 
  



Part 2. Seating Charts 
 
Check these websites for UCSD seating charts: 
 
Classroom Details: 
https://blink.ucsd.edu/faculty/instruction/tech-guide/classroom/details.html 
 

• BLINK (blink.ucsd.edu) → “Instruction” menu → “Classroom Details” 
• PDF seating charts for most Registrar-controlled classrooms that have seat numbers. 
• Newer classrooms may not be available yet. 

 
Academic Integrity Office: 
https://academicintegrity.ucsd.edu/take-action/prevent-cheating/faculty/exam-
rules.html#Assign-seats 
 

• This has EXCEL spreadsheets of seat numbers in selected large rooms. 
• If your room has seat numbers but they don’t have a spreadsheet for it, you can make 

your own in a similar format, to use with the instructions here for randomized seats. 
 
If the room doesn’t have seat numbers: 

• Sometimes it’s feasible to tape up row and column signs A,B,C,… and 1,2,3,…; or to tape 
seat number signs or names on individual chairs; but sometimes it’s not. 

• If the room is small, it also may be feasible to make a slide with students’ names on a 
drawing of the seat map, and show the slide as students arrive for the exam. 

 
 
Check out the room in advance: 

• Visit it before making the seating chart at a time when the room is empty. If it isn’t free 
before or after your class, or if it’s not your regular classroom, then check the class 
schedule for when it’s available. 

• Bring a printout of the seating chart from the Classroom Details website (if available), or 
take photos or draw your own. 

• If broken seats or other issues were noted on the seating charts from the Classroom 
Details or AIO websites, then check if they still apply. Also check for broken seats, 
missing seat labels, etc. You can report anything needing repairs, but it may not be fixed 
in time for your exam, so avoid assigning them. 

• Decide where to collect exams, like a table in the front. But if you’re using front row 
desks with seat numbers, then don’t assign those seats or other seats near them. 

 
  



Sample announcement to find who needs special seating arrangements. Announce about 2 
weeks before the first exam. Be sure to customize this for the particulars of your class: 
 

 
We will be assigning seats for the midterm, and some students will be assigned to a second 
room. Please watch for an announcement with your room and seat assignment. 
 
If you would like to be assigned a left-handed desk or have other seating issues, please email 
the instructor by [date]. 
 
Accommodations: If you have an AFA letter from OSD and have not yet notified the 
instructor, please send it now. 
 

 
 
Left-handed seats and other special seating requests: 

• If your room has left-handed (LH) seats, announce this about 2 weeks in advance 
(lecture, Canvas Announcements, exam announcement, …) 

• Keep list of LH students for other exams but adjust for drops 
• Manually assign those students to LH seats. Remove other LH seats so they’re not 

assigned to RH students (unless class is too large) 
• I focused on LH seats, but sometimes people have other seating requests, usually due to 

accessibility 
 
Room density: 

• Use the seating map drawing and the number of right & left-handed students and seats, 
to make a plan. 

• Every other row or seat? Skip every third seat? Delete certain rows to give proctors 
access to both adjacent rows for ID checks? 

• If you’re splitting the class into multiple rooms, indicate both the room AND the seat 
number in the spreadsheet comment. 

 
  



Random seat assignments: Basic workflow 
• Step 1: Download a Canvas roster; keep the first 4-5 columns but delete the others; and 

add a “Comments” column. This was described earlier in this document. 
• Step 2: Add seats to it. Earlier we did this by typing them in, but now we’ll replace this 

step. 
• Step 3: Upload it to Canvas by the instructions earlier in this document. 

 
The AIO website has instructions from Prof. Emily Tang (UCSD Economics) for distributing 
randomized seats through TritonEd. If you are used to those instructions and want to continue 
using them, you can do “Step 2” above using the AIO instructions (but with the Canvas roster). 
 
However, I will give different instructions here for random seat assignments, which will allow us 
to format the comment like “Room SOLIS 104, Seat A-1”; handle special seat requests; sort the 
roster into left/middle/right sections; etc. 
 

• Get the AIO spreadsheet of seats for a room or make a file in the same format yourself. 
 

• Rename it since you’ll be modifying it. 
Original: center-hall-212.xlsx 
Rename: randomized-center-hall-212.xlsx 

 
• OPTIONAL: 

o In this file: Delete seats that you’re not using (front row seats, every other seat, 
broken seats, etc.). 

o In the roster file: Delete accounts you don’t need, like UCSD staff. But keep “Test 
Student” so you can test the student view. 

o We give more tips later on organizing these files to handle such situations. 
 

• Typically, the column titles are in row 2, the first seat is in row 3, and the “UNIQUE 
SEATING #” of the first seat is in cell C3. The instructions below assume those, but you 
may need to adjust these. 
 

• Complication: Part 4 really should go here, but it’s messy, so I’m postponing it. It 
concerns adding formulas that will allow us to sort seats into physical order.  
 

• Create a new column “Formatted” to format the seat as “Seat: A-1” or “Room: Center 
212, Seat: A-1” 

o Column title (in row 2): “Formatted” 
o Formula for first seat (in row 3): depends on how many rooms you’re using: 

§ 1 room: =CONCAT("Seat: ",C3) 
§ 2+ rooms: =CONCAT("Room: Center 212, Seat: ",C3) 

o Copy the formula down the rest of the column 
 



• Create a new column “Randomize” of random numbers (decimals between 0 and 1): 
o Column title (in row 2): “Randomize” 
o Formula for the first seat (in row 3): =RAND() 
o Copy the formula down the rest of the column 
o You’ll get random decimals between 0 and 1. They will keep changing each time 

the spreadsheet is recalculated; don’t worry about it. 
 

• Select all the seat rows and use Data → Sort to sort them by the column “Randomize”. 
o Depending on your spreadsheet’s options, you may have to include the title row 

in your selection and sort by “Randomize”, or you may have to sort by it’s 
column letter, like “Column G”. 
 

• Copy seats into the seat roster spreadsheet: 
o Count how many seats you need 
o CUT or COPY as many seats as you need from the “Formatted” column of this 

spreadsheet, into the “Comments” column of the seat roster spreadsheet. If 
there will be multiple copy/paste operations involved, then I suggest using CUT 
instead of COPY, in order to avoid assigning the same seat twice. 

o You must use PASTE SPECIAL as VALUES into the seat roster spreadsheet. 
Ordinary PASTE won’t work correctly between spreadsheets due to formulas. 
 

• Save the roster as CSV and upload it to Canvas. 
 

  



Handling special seat assignments, two rooms, etc.: 
 
I suggest organizing your roster into several groups: 

• First, the main group of students is at the top 
• Then, add sections on your roster spreadsheet for the students requiring special 

handling and move students into them, such as 
o OSD separate room 
o Left-handed 
o Other special seats in room 
o Staff on the roster 
o Section A05 in overflow room 

• In the slides, I separated these sections by blank lines and made section titles “OSD 
separate room”, etc., with yellow highlighting. These titles should ONLY be in Column A 
(“Student”); leave the other columns in those rows blank, and then the row will be 
ignored when you upload the CSV. 

• Also add sections on your seat list spreadsheet, such as 
o Right-handed 
o Left-handed 
o Empty 
o Broken 

• Randomize the right-handed seat list and left-handed seat list separately. 
• CUT or COPY from the right-handed seat list and 

PASTE SPECIAL as VALUES to the right-handed student list on the roster. 
Do the same for the left-handed list. Handle the other groups as needed. 

 
 
  



Part 3. Assigned seats exam logistics 
 
Optional prep before exam: Pre-counting stacks of exams 

• Pre-count exams into stacks to hand out quickly (either number of assigned seats or 
number of physical seats) 

• Optionally write seat numbers in the upper corner of each exam 
• Bring extra exams as this may not go as planned (wrong seats, late arrivals, ...) 

 
Sample announcement before handing out exams 
Be sure to customize it for the particular details of your exam 
 

Example A: If you marked seat #s on exams and skipped seats 
 
Please sit in your assigned seat. 
Do not switch seats without our permission. 
 
Take the test with your seat # from the TOP of the pile. Keep it face down until we announce 
to start the test. 
 
If someone is late, place the test with their seat # on their desk. Colors will alternate and 
some seats will be empty. 
 
You need to have out your exam booklet, UCSD ID card, pencils (or pens) and erasers, 
optional note sheet, and calculator. 
 
No books, phones, laptops, smart watches, etc. Disable and put away your phones and other 
devices. 
 

 
 
 

Example B: Packed rows, didn’t mark seat #s on exams, and there are only instructions on 
the first page but no test questions: 
 
Then replace “Take the test with your seat # from the TOP of the pile. Keep it face down until 
we announce to start the test.” by: 
 
As exam booklets are passed out: 

• Do not start until we say to. 
• Instructions up, exams closed, until we say to start. 
• Colors should alternate, including on empty seats. 

 
 



 
Prep before exam: Printouts of roster 

• Print rosters with name, PID, (sec. # if needed), seat # 
o You can hide the other columns 
o Make alphabetical order version and seat order version (stapled together) 
o Bring several printouts of each for prof/TAs/proctors helping check IDs (and 

collect all the copies as they complete the ID checks) 
o Optional: on exam day, make list of who dropped since seats were assigned 

 
• If the room has sections, I organize the seat roster as: 

              Left section rows A,B,C,…    Middle A,B,C,…     Right A,B,C,… 
  
Checking UCSD ID cards / attendance 

• Some faculty check IDs as students enter the room, or as they turn in exams (use 
alphabetical roster) 

• I check IDs during the exam (use seat order roster) 
• Proctors can split up room: 

o Check IDs in left/middle/right sections; 
o Or one proctor works front to back and another works back to front 

• Discrepancies: 
o Note any issues (alternate ID, no ID, wrong seat, late, absent, ...). 

If multiple proctors check IDs, compare notes to reconcile discrepancies 
o No ID: Maybe you or TA knows them. Check photo on Instruction Tools. Ask 

them to show name & PID on front of exam. 
o Wrong seat: 

§ Before exam: Use alphabetical roster to help them find their seat 
§ During exam: I usually just note it but don’t move them, as it’s disruptive 

o No shows: After checking all IDs, call no shows’ names, just in case 
   



Part 4. How to sort the roster into seat order 
 
We need to change or add formulas in the AIO seat list spreadsheets to facilitate sorting 
random seat assignments back into the physical seat order in the room. This is based on the AIO 
seat list spreadsheet format as of October 2021. If they incorporate changes like these (or 
another solution) in the future, it may simplify the situation. 
 
 
First scenario: If you want the seats to be ordered A-1, A-2, …, B-1, B-2, … 
 
Second scenario: If your room has left/middle/right sections and you want to sort it as 
  Left section rows A,B,C,…    Middle A,B,C,…     Right A,B,C,… 
or if you have a room like the Price Center Theater in which the seats don’t have consecutive 
numbers: 

Left: A-12,10,8,6,4,2    Middle: A-101,102,…,110   Right: A-1,3,5,7,9,11 
 
 
 
 
First scenario: Sorting these seat numbers in EXCEL: 

A-1, A-2, …, A-10, A-11, A-12 
gives: 

A-1, A-10, A-11, A-12, A-2, …, A-9 
 

 
If you want the order A-1, A-2, …, B-1, B-2, …, for your room, then here’s a quick workaround: 
 

• In the AIO seat list spreadsheet, the first seat in the “UNIQUE SEATING #” is usually in 
spreadsheet cell C3, and is generated by a formula 

=CONCATENATE(A3,"-",B3) 
• Change that formula to this instead: 

=IF(B3<10,CONCATENATE(A3,"- ",B3),CONCATENATE(A3,"-",B3)) 
• This adds a space before single-digit numbers, so we get “A- 1” with a space, but “A-10” 

without a space. These sort into the desired order: 
“A- 1”, “A- 2”, …, “A- 9”, “A-10”, “A-11”, “A-12” 

 
Another workaround would be to copy the Row (“A”) and Seat # (“1”) columns into the roster 
so that it could be sorted by those columns separately, but that would introduce complications 
of having to delete those columns to export a CSV. If you just want the order A-1,…,A-12, then 
the way shown above turns out to be simpler. 
 
 
  



Second scenario: If your room has left/middle/right sections and you want to sort it as 
  Left section rows A,B,C,…    Middle A,B,C,…     Right A,B,C,… 
or if you have a room like the Price Center Theater in which the seats don’t have consecutive 
numbers: 

Left: A-12,10,8,6,4,2    Middle: A-101,102,…,110   Right: A-1,3,5,7,9,11 
then read on for another solution. 
 

• The AIO seat spreadsheet usually is in this order, including for Price Center Theater: 
row A left-to-right (ignoring any split into left/middle/right sections), 
row B left-to-right, etc. 

• If you prefer it to be in left section A,B,C,…, middle section A,B,C,…, right section 
A,B,C,…, or some other order, then manually rearrange the AIO spreadsheet into the 
order you want BEFORE following the instructions for randomized seat order. 

• Then, add a new column called “Sequence”. 
o Enter the word “Sequence” in the title row (usually cell F2) 
o Enter 1 in the cell just below it (for the first seat; usually cell F3). 
o Then in the cell below that (F4), enter the formula  =F3+1 

(adjust that formula if the cell address is different). 
o Copy/paste that formula down the rest of the column. 
o COPY the whole column F 

and PASTE SPECIAL as VALUES to column G. 
o Delete column F. 
o Now the new column F is just the sequence numbers 1,2,3,… without formulas. 

• Now add the “Formatted” and “Randomize” columns as explained before. 
• When you copy seats from this spreadsheet to the roster spreadsheet, take TWO 

columns: CUT/COPY both the “Sequence” and “Formatted” columns for as many seats 
as needed, and PASTE SPECIAL as VALUES into the roster spreadsheet. 

• In the roster spreadsheet, the names of those two columns should be “Sequence” and 
“Comments”. 

• You can now sort the roster by the “Student” column to get it in alphabetical order, or 
by the “Sequence” column to get it into seat order. 

• Save the roster in EXCEL format and make nicely formatted versions of it for printing. 
• For the Canvas CSV file: 

o Temporarily delete the “Sequence” column 
o Save/Download/Export as CSV 
o Use “Undo” to bring back the “Sequence” column. 

(if your spreadsheet doesn’t autosave, you may be able to quit at this point 
instead of using undo. If you’re using a web-based spreadsheet like Google 
Sheets that saves every change you make, you MUST use “Undo” at this point.) 

 
 
 


